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Safety Compliance

Safety Statement

This equipment has been tested to comply with USA and Canadian safety
certification in accordance with the specifications of UL Standards: UL60065 7th
/IEC 60065 7th and Canadian CAN/CSA C22.2 60065:03. Avid Inc., has been
authorized to apply the appropriate NTRL mark on its compliant equipment.

Warning

RISK OF ELECTRIC SHOCK
DO NOT OPEN

A

Important Safety Instructions
1) Read these instructions.

2) Keep these instructions.
3) Heed all warnings.
4) Follow all instructions.

5) Only perform the services explicitly described in the install and or user
manual. For services or procedures not outlined in the install or user manual,
speak with authorized service personnel.

6) Do not use this equipment near water.
7) Clean only with dry cloth.

8) Do not block any ventilation openings. Install in accordance with the
manufacturer’s instructions.

9) Do not install near any heat sources such as radiators, heat registers, stoves,
or other equipment (including amplifiers) that produce heat.

10) Do not defeat the safety purpose of the polarized or grounding-type plug. A
polarized plug has two blades with one wider than the other. A grounding type
plug has two blades and a third grounding prong. The wide blade or the third
prong are provided for your safety. If the provided plug does not fit into your
outlet, consult an electrician for replacement of the obsolete outlet.

11) Protect power cords from being walked on or pinched particularly at plugs,
convenience receptacles, and the point where they exit from the equipment.

12) Only use attachments/accessories specified by the manufacturer.

13) For products that are not rack-mountable: Use only with a cart, stand, tripod,
bracket, or table specified by the manufacturer, or sold with the equipment.
When a cart is used, use caution when moving the cart/equipment combination
to avoid injury from tip-over.

14) Unplug this equipment during lightning storms or when unused for long
periods of time.

15) Refer all servicing to qualified service personnel. Servicing is required when
the equipment has been damaged in any way, such as power-supply cord or
plug is damaged, liquid has been spilled or objects have fallen into the
equipment, the equipment has been exposed to rain or moisture, does not
operate normally, or has been dropped.

16) For products that are a Mains powered device:
The equipment shall not be exposed to dripping or splashing and no objects
filled with liquids (such as vases) shall be placed on the equipment.

Warning! To reduce the risk of fire or electric shock, do not expose this
equipment to rain or moisture.

17) For products containing a lithium battery:
CAUTION! Danger of explosion if battery is incorrectly replaced. Replace only
with the same or equivalent type.

18) The power inlet is the main disconnect device and should remain
accessible. Disconnect the power cord before servicing the unit.

19) The equipment shall be used at a maximum ambient temperature of 40° C.

Rack-Mount Safety Instructions

1) Elevated Operating Ambient - If installed in a closed or multi-unit rack
assembly, the operating ambient temperature of the rack environment might be
greater than room ambient. Therefore, consider installing the equipment in an
environment compatible with the maximum ambient temperature (Tma)
specified by the manufacturer.

2) Reduced Air Flow - Installation of the equipment in a rack should be such that
the amount of air flow required for safe operation of the equipment is not
compromised. Stage 48 airflow is from the front of the chassis enclosure to the
rear. Make allowances for cooling air to be available to the front panel surface
and no restrictions at the rear.

3) Mechanical Loading - Mounting of the equipment in the rack should be such
that ahazardous condition is not achieved due to uneven mechanical loading.

4) Circuit Overloading - Consideration should be given to the connection of the
equipment to the supply circuit and the effect that overloading of the circuits
might have on overcurrent protection and supply wiring. Appropriate
consideration of equipment nameplate ratings should be used when addressing
this concern.

5) Reliable Earthing - Reliable earthing of rack-mounted equipment should be
maintained. Particular attention should be given to supply connections other
than direct connections to the branch circuit (for example, use of power strips).
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Part |I: Overview



Chapter 1: Introduction to the VENUE | S3L-X System

Welcome to the VENUE | S3L-X digital live mixing system from Avid®. The S3L-X system includes the S3 control surface, the E3 en-
gine, and up to four Stage 16 remote 1/0 boxes, providing a compact, modular, scalable, and high-fidelity live mixing solution using ul-
tra-reliable and low-latency Ethernet AVB audio network connections.

The S3L-X system uses the same intuitive and powerful VENUE software used by all other systems in the Avid live systems family,
providing Show file portability between Avid live systems, direct Pro Tools® connectivity and interoperability, and support for

Pro Tools-compatible plug-ins. The S3L-X system allows provides Stage input sharing: share up to four Stage 16 remote stage boxes
between multiple E3 engines, with automatic gain tracking for shared inputs.

Stage16

S3L-X system components: S3 control surface (top), E3 engine (middle) and Stage 16 remote stage 1/O box (bottom)

Chapter 1: Introduction to the VENUE | S3L-X System 1



S3L-X System Features

S3L-X System Processing

The S3L-X system provides the following processing features
and capabilities:

64 input processing channels, each with built-in High-Pass
Filter, Dynamics and EQ processors

35 output processing channels, each with a built-in Com-
pressor/Limiter and 4-band fully parametric EQ

16 assignable 31-band Graphic EQs available for output
channels

» Three Main busses, configurable as Left-Center-Right or
Left-Right+Mono

27 busses total (24 mix busses plus three Main busses), eight
mono stereo-linkable Matrixes, and eight VCAs
* 40 plug-in rack slots for Pro Tools compatible plug-ins

S3L-X System Recording and Playback
Features

S3L-X provides the following recording and playback capabili-
ties:
» 64 channels of fully integrated recording and 64 channels of
playback with a compatible Pro Tools system, including
true Virtual Soundcheck capability

» VENUE Link, providing Pro Tools and VENUE interopera-
bility and interconnection, including Pro Tools Transport
control from the S3 control surface

* Built-in USB 2-track recording and playback

Q For complete system requirements and a list of qualified
" computers, operating systems, and third-party devices,
visit www.avid.com/S3Lsupport

Stage Input Sharing

S3L-X provides the following stage input sharing capabilities:

 Share up to four Stage 16 remote stage boxes between mul-
tiple E3 engines

 Automatic gain tracking on a per-channel basis across all E3
engines and applied at all times, even during a snapshot
store or recall

« Independent control of the full range of input gain control
(+10dB to +60dB) from every E3 on the network

« Intelligent communication between E3 engines providing
ongoing device connectivity, assignment, health and status
monitoring

» Redundant connections to shared Stage 16 units in sup-
ported connection configurations

S3 Control Surface Features

The S3 control surface provides system controls, mix position au-
dio 1/0, and control and utility connections.

System Controls

16 bankable fader strips, each with a touch-sensitive fader,
one multi-purpose assignable rotary encoder, solo, mute and
select controls

¢ Level meters on each fader strip

 Channel Control section for control of input settings, Dy-
namics and EQ settings (built-in or plug-ins), and Aux sends

< Eight rotary encoders for global control of parameters such
as output level controls and plug-ins

 Touch Strip for customizable control of system parameters

« Eight customizable function switches providing instant ac-
cess to up to 16 system parameters

Audio 1/0
« Two analog mic/line XLR inputs with mic preamps for con-
necting microphones or line-level devices at the mix posi-
tion
» Two analog line inputs and four analog line outputs for con-
necting other line-level devices at the mix position

Control and Utility Connections
¢ Two Neutrik etherCON RJ-45 Ethernet Network ports for
connecting to the E3 engine and/or a compatible Pro Tools
system

» Two USB ports for keyboard and mouse/trackball (only)
¢ One 1/4-inch stereo headphone connector
e One 1/4-inch TRS footswitch connector

¢ Two XLR console light connectors (LED console lights re-
quired)

Standalone DAW Control and Audio
Interface

S3 provides the following features as a standalone studio control-
ler and Ethernet AVB audio interface with compatible computers
running EuControl 3.2 or higher:

e Control of EUCON™-aware DAWS, including Pro Tools,
Apple Logic, Steinberg Cubase/Nuendo, MOTU Digital
Performer, Cakewalk SONAR, and more.

« Integrated automation controls

* Integrated transport controls

 4x6 audio interface, including two mic inputs and Main and
Alt monitoring outputs, all controllable from the surface

For complete information on using S3 standalone, see the
S3 User Guide. For compatibility information and a FAQ,
visit www.avid.com/S3-Surface-Support.
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E3 Engine Features

The E3 engine provides mix position audio 1/0, and connections
for synchronization, utility and control. The E3 engine also
houses the main CPU, DSP, and system drives for the S3L-X sys-
tem. The E3 engine is located at the mix position along with the
console.

Audio 1I/0
* Four analog mic/line XLR inputs with mic preamps for con-
necting microphones or line-level devices at the mix posi-
tion
» Four analog line-level XLR outputs
» Two stereo AES/EBU digital inputs

» Two stereo AES/EBU digital outputs

Synchronization, Control and Utility
Connections

» Three Neutrik etherCON RJ-45 Ethernet Network ports for
connecting to the S3 control surface and Stage 16 boxes

* One standard RJ-45 Ethernet port for connecting to a client
computer or networking equipment to enable ECx Ethernet
Control remote system control

 Three external USB 2.0 ports for connecting USB storage
devices (for data transfer, and for 2-track recording and
playback), iLok USB Smart Keys (for plug-in authoriza-
tion), and compatible MIDI devices

* One internally-mounted, secure USB 2.0 port for an iLok

* 16 channels of MIDI input and 16 channels of MIDI output
via a compatible external USB MIDI interface

» DVI video monitor port for software screen display
» Word clock I/O for digital clock synchronization

* One RJ-45 (100 BaseT Ethernet) port for ECx Ethernet
Control remote system control

* One GPIO port (DB9 connector) providing two GPI inputs
and two GPI outputs

 An internal universal PSU (100V to 240V nominal 50-60
Hz) accepting standard IEC AC power cables

CPU, DSP, and System Drives

The E3 engine houses the CPU, Avid Pro Tools|HDX-powered
DSP, and system drives that provide the processing power to run
the VENUE software and plug-ins for your system. The USB
ports on the E3 engine allow you to do the following:

» Update and restore your VENUE system software
* Install compatible plug-ins

 Transfer VENUE Show files and other data

» Record and play back 2-track audio

Stage 16 Remote Stage Box Features

Stage 16 provides remote stage 1/O for S3L-X systems in a 4U
rack-mountable enclosure. The S3L-X system supports redun-
dant audio snake connections to up to four Stage 16 boxes. Audio
snake connection are made using supported Ethernet cables (see
Audio Network Connections).

Audio 1/0
16 analog inputs with remotely controllable mic preamps
and individually selectable phantom power

« Eight analog outputs
» Four AES digital output channels (on two stereo connectors)

Control Connections
e Two Neutrik etherCON RJ-45 Ethernet Network ports for
connecting to the E3 engine and to other Stage 16 boxes

« An internal universal PSU (100V to 240V nominal 50-60
Hz) accepting standard IEC AC power cables
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What's Included

S3 Control Surface

Each S3 control surface includes the following:
 S3control surface
 Avid mouse pad

* One (1) external universal power supply (100V to 240V
nominal 50-60 Hz)

* One (1) IEC power cable, North American standard
¢ S3L-X System Quick Setup Guide

 Other documentation, including a Health and Safety Guide, a
Welcome Letter, and a Registration card

» VENUE Tech Support card (for obtaining tech support for
your system)

E3 Engine

Each E3 engine includes the following:
» E3engine
 Hardware for rack installation
* Replacement screws
» One (1) IEC power cable, North American standard
» S3L-X System Software & Plug-Ins pack
» Pro Tools software package
e S3L-X System Quick Setup Guide
e S3L-X Software Installation Guide
* S3L-X Quick Start Guide reference card
 Other documentation, including a Health and Safety Guide, a
Welcome Letter, and a Registration card

» VENUE Tech Support card (for obtaining tech support for
your system)

S3L-X System Software & Plug-Ins Pack

VENUE System Restore USB Drive The VENUE System Re-
store USB Drive contains VENUE System Restore software.
This software is used for S3L-X system maintenance only. Keep
this drive with the system at all times.

A Do not use this drive for anything other than VENUE Sys-
tem Restore software. Do not use this drive to store
VENUE Show files, audio files, or any other data or soft-
ware, including VENUE software updates.

S3L-X Plug-Ins iLok An iLok USB key (2nd generation) is in-
cluded in this package to store your S3L-X plug-in licenses. To
run the S3L-X plug-ins on your S3L-X system, this iLok contain-
ing plug-in licenses must be connected to your E3 engine at all
times.

For more information on the activation process for your
S3L-X system software, go to www.avid.com/activation-
card and select S3L-X.

Activation Card The Avid S3L-X System Software & Plug-Ins
Activation Card is used to activate your S3L-X software and
plug-ins. This activation process deposits the following iLok li-
censes into your iLok account:

e S3L-X plug-in licenses
» Live Sound Production Toolkit license

The activation process also deposits the following S3L-X soft-
ware downloads and documentation into your Avid account:

e S3L-X plug-in installers
» Latest VENUE software update (if any)

e ECx Ethernet Control host and client software (for remote
control of your S3L-X system)

VENUE Standalone software
* Documentation

EuControl 3.2 software (enables S3 to be used as a stand-
alone studio controller for EUCON-enabled DAWS, includ-
ing Pro Tools)

A A separate USB flash drive (not provided) is required
to store software installers and documentation. Do not
use the included VENUE System Restore USB Drive.

Pro Tools Software and the Live Sound Production
Toolkit

Pro Tools software is included with the E3 engine, and is acti-
vated and downloaded separately from the S3L-X system soft-
ware and plug-ins. The Live Sound Production ToolKkit is an iLok
license that enables up to 64 channels of 1/0 between your S3L-X
system and your Pro Tools computer.

¢ AN iLok 2 is also included in the Pro Tools package to store
- your Pro Tools and Live Sound Production Toolkit li-
censes. Do not store S3L-X system plug-in licenses and
Pro Tools licenses on the same iLok. You can, however, use
the same iLok account to manage all iLok licenses.

Stage 16

Each Stage 16 includes the following:
 Stage 16 remote 1/O box
» Hardware for rack installation
* Replacement screws

* One (1) IEC power cable, North American standard
e S3L-X System Quick Setup Guide

e Other documentation, including a Health and Safety Guide, a
Welcome Letter, and a Registration card

» VENUE Tech Support card (for obtaining tech support for
your system)
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Additional Required Components

The following required components must be purchased sepa-
rately:
 Shielded Cat 5e (350 MHz) or better Ethernet cable with
Neutrik etherCON connectors (for audio network connec-
tions between components)

* Free-standing DVI-D compatible video monitor with
1024 x 768 minimum resolution (15-inch or greater
flat-panel TFT display recommended) and cable

» Windows-compatible USB keyboard and trackball/mouse

» USB 2.0 flash drive(s) for storing software, installers, and
documentation

Optional Components
The following components are optional, and must be purchased
separately:

« Shielded Cat 5e (350 MHz) or better Ethernet cable for con-
nections to Pro Tools

» Standard Cat 5e or better Ethernet cable for ECx Ethernet
Control connections

» USB storage device for transfer of VENUE Show files and
data (512 MB or larger recommended)

» USB 2.0 flash drive(s) for use with the built-in USB 2-track
recording and playback features

» Headphones with 1/4-inch connector
» Footswitch with 1/4-inch connector

» BNC cables for word clock connections to/from external
digital devices

» DB9 (9-pin) cable for connecting to GPI devices
* Two (2) LED console lights with XLR connectors

» Thunderbolt to Gigabit Ethernet adapter for connecting to
the Thunderbolt port of a qualified Pro Tools computer

Operational Requirements

Temperature and Ventilation

S3L-X system devices should be operated away from heat
sources and with adequate ventilation.

@ Hardware monitoring and automatic warnings are provided
for temperature, power and other factors. For more informa-
tion, see Hardware Monitoring Window.

Storage

S3L-X system devices should be stored and transported at tem-
peratures not lower than 0 degrees F (—18 degrees C) and not ex-
ceeding 140 degrees F (60 degrees C).

Operation

S3L-X system devices should be operated at temperatures not
lower than 40 degrees F (4 degrees C) and not exceeding
104 degrees F (40 degrees C).

During operation, the bottom panels of the S3 control surface, the
front and back panels of E3 engine, and the side panels of the
Stage 16 should be exposed to ambient air. Do not block the ven-
tilation holes on any S3L-X system component.

Do not operate in direct sunlight or at extreme ambient tempera-
tures.

Water and Moisture

S3L-X system devices should be operated away from sources of
direct moisture and should be kept clear of liquids that might spill
into the units. If condensation is present on the unit, leave the unit
to dry in ambient air for at least one hour before powering the unit
on.

Storage humidity range 5% to 95%, non-condensing

Operating humidity range 20% to 80%, non-condensing

Cleaning and Maintenance

Use a dry cloth to clean the surfaces of the S3L-X components.
Do not apply any cleaning solutions, spray cleaners, or abrasives
to the surface.
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Connection Requirements

Power Connections

Power connections on all S3L-X system devices are auto volt-
age-selecting (100 to 240V nominal, 90-260V maximal, 50-60
Hz).

Make sure your power source is correctly rated for the number of
units you are connecting. A surge-protected power source (not in-
cluded) is highly recommended.

Audio Connections
 All audio inputs and outputs (except Headphones) are bal-
anced XLR and/or balanced 1/4-inch connections.
* All 1/4-inch connections support balanced (TRS) and unbal-
anced (TS) connections.

 All external digital audio inputs and outputs are AES/EBU
(XLR) connections.

For more information on audio connectors and specifica-
tions, see Audio Specifications.

Audio Network Connections

Shielded Cat 5e (350 MHz) or better Ethernet cable with Neutrik
etherCON connectors are required for primary and redundant au-
dio network connections between the console, the E3 engine, and
any Stage 16 boxes. Maximum distances of 100m are supported
for all audio network connections.

Pro Tools Connections

Shielded Cat 5e (350 MHz) or better Ethernet cable with RJ-45
connectors is required for the Ethernet AVB connection to
Pro Tools.

ECx Ethernet Control Connections

Standard Cat 5e Ethernet cable with RJ-45 connectors are sup-
ported for ECx remote control connections to a client computer or
wireless/wired router.

System Requirements and

Compatibility

Avid can only assure compatibility and provide support for hard-

ware and software it has tested and approved. For complete sys-

tem requirements and a list of qualified computers, operating sys-

tems, hard drives, and third-party devices, visit:
www.avid.com/compatibility

About www.avid.com

The Avid website (www.avid.com) is your best online source for
information to help you get the most out of your system. The fol-
lowing are just a few of the services and features available.

Product Registration Register your purchase online.

Support and Downloads Contact Customer Success (technical
support); download software updates and the latest online manu-
als; browse the Compatibility documents for system require-
ments or search the online Knowledgebase.

Training and Education Study on your own using courses
available online or find out how you can learn in a classroom set-
ting at a certified Avid training center.

Products and Developers Learn about Avid
products; download demo software or learn about our Develop-
ment Partners and their plug-ins, applications, and hardware.

News and Events Get the latest news from Avid or sign up for a
product demo.

Pro Tools Accelerated Videos Watch the series of free tutorial
videos. Accelerated Videos are designed to help you get up and
running with Pro Tools and its plug-ins quickly.

Live Sound Webinars Watch free tutorial videos and live sys-
tem-specific webinars to learn from the experts.

To learn more about these and other resources available from
Avid, visit our website (www.avid.com).

Registration

Review the enclosed Registration Information Card and follow
the printed instructions to quickly register your purchase online.
By registering, you become eligible to receive the following:

« Technical support information
« Software update and upgrade notices
» Hardware warranty information
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Conventions Used in This Guide

All of our guides use the following conventions to indicate menu
choices and key commands:

Convention Action

In the VENUE software, click
Options to display the Options tab,
then click the System tab.

Options > System

File > Save Choose Save from the File menu

Control+N Hold down the Control key and
press the N key

Control-click Hold down the Control key and click
the mouse button

Right-click Click with the right mouse button

The names of Commands, Options, and Settings that appear
on-screen are in a different font.

The following symbols are used to highlight important informa-
tion:

Q User Tips are helpful hints for getting the most from your sys-
tem.

A Important Notices include information that could affect your
data or the performance of your system.

Shortcuts show you useful keyboard or mouse shortcuts.

Cross References point to related sections in this guide and
other VENUE guides.

Hardware Switches on S3 Control
Surface

The names of switches on the S3 control surface are in bold (such
as Sel). The Shift switch on the S3 is indicated by bold text, in
all-caps (SHIFT) to distinguish it from references to the Shift key
on your QWERTY keyboard.

SHIFT and SHIFT Lock

The SHIFT switch on the S3 is used in conjunction with other
keys to access secondary functions Some switches have second-
ary functions, highlighted in gray above the primary function
(such as < Bank/Home, where Home is the secondary function).
The following terminology is used to describe SHIFT functions.

Example:

» “Press and hold the SHIFT switch then press the Back/Top
switch”

is written as
e “Press SHIFT+Back/Top”

How to Use this PDF Guide

These are some useful features of this PDF:

» The Bookmarks on the left serve as a continuously visible
table of contents. Click on a subject heading to jump to that
page.

« Click a + symbol to expand that heading to show subhead-
ings. Click the — symbol to collapse a subheading.

» The Table of Contents provides active links to their pages.
Select the hand cursor, allow it to hover over the heading un-
til it turns into a finger. Then click to locate to that subject
and page.

« All cross references in blue are active links. Click to follow
the reference.

* Select Find from the Edit menu to search for a subject.
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Chapter 2: Configuring and Connecting

The chapter shows how to get your system up and running by do-
ing the following:

 Unpack and assemble the components

¢ Connect the power and peripherals (monitor, USB keyboard
and mouse)

 Connect your system in either of the following configurations:

» Connect one S3, one E3 and up to four Stage 16s in a basic
system

 Connect two S3s, two E3s and up to four Stage 16s in a
shared input configuration

» Power up the system

¢ Confirm system components
 Enable Config mode

* Set up the system for the first time
 Set the system clock

 Connect Audio (S3 control surface, E3 engine, and Stage 16 in-
puts and outputs), synchronization, and lights

« Install other optional software or updates

Unpacking and Assembling System
Components

Unpacking System Components

« Remove all components from the shipping packaging.

« Place the S3 control surface on a table or other stable surface
that leaves full access to its front and back panels.

« Locate the E3 engine at the mix position along with the S3
control surface.

« Make sure all components are free of any bags, padding or
other materials.

« Keep cables and other included items organized, making sure
to keep them with their associated component after unpacking.
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Connecting Power

S3 Control Surface
The external PSU for the S3 control surface is connected to the
DC input on the S3 and to your power source.

To connect power to the S3 control surface:

1 Connect one end of the included IEC power cable from the ex-
ternal PSU to your power source. Make sure the power cable is
pushed all the way into the PSU.

@y

Connecting the IEC power cable to the S3 control surface PSU

2 Connect the cable with the 4-pin connector that is attached to
the PSU to the DC power input on the back panel of the S3. To
correctly align the pins on the connector with the power input,
make sure the arrow on the connector faces up.

S3 control surface DC power input

E3 Engine

The AC power input for the E3 engine is located on the back
panel.

To connect power to the E3 engine:

= Connect the included IEC power cable from the AC power in-
put on the back panel of the E3 engine to your power source.

o
5
g
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<

E3 engine AC power input

Stage 16

The AC power input for the Stage 16 is located on the back/bot-
tom panel of the box. One male, 3-pin North American standard
IEC power socket with cable retaining tie is provided. The input
and power switch are recessed to allow the box to sit on its back.

(¥ You can reconfigure the rack ears on Stage 16 as handles.
See Configuring Stage 16 Rack Ears/Handles.

To connect power to the Stage 16:

1 Connect the included IEC power cable from the AC power in-
put on the back of Stage 16 to your power source.

Stage 16 AC power input, power switch, and cable tie

2 (Optional) Secure the power cable to the rack using the built-in
cable tie.
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Connecting Peripherals

Connecting a Monitor

A DVI connector is provided on the E3 engine to connect a
DVI-D compatible video monitor (not included).

NYOMLIN

E3 engine back panel DVI monitor port
To connect a monitor:

= PlugaDVI-D compatible monitor cable from the DV connec-
tor on the back panel of the E3 engine to your DVI monitor.

A\ VGA monitors are not compatible with the S3L-X system.

Connecting a USB Keyboard and Mouse

There are two USB 2.0 ports on the back of the S3 control surface
to connect a USB keyboard and trackball/mouse.

0C )0 oC )0
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S3 control surface back panel USB ports
To connect a USB keyboard and trackball/mouse:

= Plug the keyboard and trackball/mouse into the USB ports on
the back of the S3 control surface.

A Use these USB ports for mouse and keyboard connections
only. Connect USB data storage devices and iLoks to avail-
able USB ports on the E3 engine.

A When performing a system update or system restore, the
keyboard and mouse must be connected to the E3 engine.
See Using the System Restore Software.

A When configuring a shared Stage input system, make sure
the mouse is attached to the E3 engine.

Connecting an S3L-X System

After connecting power and peripherals, make audio network
connections between system components. You can also make
connections to Pro Tools, and to a router or client computer for
remote control of your S3L-X system using ECx Ethernet Con-
trol.

* For connecting a basic system that includes one E3 engine
and one S3 control surface, see Connecting a Basic Sys-
tem.

 For connecting a shared Stage input system that includes
two E3s and two S3s, see Connecting a Shared Stage In-
put Configuration.

S3L-X Network Connections Overview

The S3L-X system has two discrete networks, the AVB audio
network and the ECx Ethernet Control network. The AVB audio
network connects all S3L-X system components and Pro Tools.
The ECx network connects a client computer or other device (di-
rectly or via network equipment) to S3L-X to enable remote con-
trol of your system.

AVB Audio Network Connections

Direct connections are required for all AVB audio network con-
nections between S3L-X system components, and between the S3
control surface and Pro Tools.

A\ Do not connect network equipment such as routers, hubs
and switches to any S3L-X system Network ports.

S3L-X System Components

Connections are required between the S3 control surface and the
E3 engine, and between the E3 engine and all Stage 16 boxes. For
shared Stage input configurations, connections between all E3
engines on the network are required.

Pro Tools

You can connect a qualified computer running a compatible ver-
sion of Pro Tools software to the S3 control surface or the E3 en-
gine for recording and playback 1/0 and for VENUE Link data
communication. For more information on installing and using
Pro Tools, see Pro Tools Recording and Playback.

A\ Use only the required audio network cables to make audio
network connections between S3L-X system components
and Pro Tools. See Audio Network Connections.

ECx Ethernet Control Connections

You can connect a network rout